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Creating a Trusted Location with Excel Services 
 
Description: 
Once you have successfully installed Microsoft® Office SharePoint® Server 2007; you will need to configure ñTrusted 
Locationsò for Excel Services before you can start rendering Microsoft Office Excel® 2007 documents by using Excel 
Services. This document outlines the steps for adding trusted locations to the Excel Services configuration. 
 
Finished Product: 
Once you are done, you will have the following: 
 

1. A Trusted Location added to Excel Services configuration. 
 

 
 
 
Collateral: 
None 
 
 
 
 
 
Prerequisites: 
This tutorial assumes that you have already completed the following tasks: 
 

1. Installed Office SharePoint Server 2007. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Steps: 
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Here are steps for adding a Trusted Location to the Excel Services configuration. In this example, the server root with 
ñChildren are trustedò is added so that all document libraries on the server are trusted by Excel Services. 
 

1 Once the installation is 
completed, you will 
have a group for 
Microsoft Office 
Server on the Start 
menu. 
 
Go to SharePoint 3.0 
Central 
Administration. 
 
 
Note: 
If you have installed 
Office SharePoint 
Server 2007 by 
clicking the Install 
Now option, the entire 
computer is trusted for 
you automatically. 
 

 
 

2 On the SharePoint 
Central Administration 
Web site, click 
SharedServices1. 

 
 

3 On the Shared 
Services 
Administration page, 
in the Excel Services 
Settings section, click 
Trusted file 
locations. 
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4 The list of trusted 
locations will be empty 
immediately after the 
installation. Click Add 
Trusted File 
Location. 

 
 

5 On the Add Trusted 
Location page, enter 
the URL of your 
server. 
You might also want to 
select the Children 
trusted check box if 
you want to render 
documents from all 
document libraries on 
this server. 
 
 

 
  
 
 

6 Scroll down to the 
External Data section 
on this page. Select 
the appropriate Allow 
External Data option, 
depending on if you 
are planning to use 
external data with 
Office Excel 2007 
documents. 
 
Click OK to add the 
trusted location. 
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7 You should see the 
trusted location added 
the list of trusted 
locations. You can 
always come back to 
this page to edit the 
settings for this trusted 
location or to add 
more trusted locations. 
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Configuring Single Sign-On for Excel Services 
 
Description: 
This document outlines the steps necessary to configure the Single Sign-On service in Microsoft® Office SharePoint® 
Server 2007 so that you can take advantage of it by using Excel Services. 
 
Finished Product: 
Once you are done, you will have Single Sign-On configured with a single application ID that you can use in Microsoft 
Office Excel® 2007 workbooks that are executed by Excel Services. 
 
Steps: 
 

1 Open the Services MMC. Right-
click Microsoft Single Sign-on 
Service, and then select 
Properties. 

 

2 On the General tab, change the 
Startup Type to Automatic. On 
the Log On tab, select the This 
account option and enter the 
credentials that you used to 
install Office SharePoint Server 
2007. 
 
Click OK to exit the dialog box. 
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3 Start the service by clicking 
Start in the Services dialog box. 
Then close the Services dialog 
box. 

 

4 Open the SharePoint Central 
Administration Web site and 
click the Operations link in the 
top navigation bar. Then under 
Security Configuration, click 
Manage settings for single 
sign-on. 
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5 On the Manage Settings for 
Single Sign-On page, click 
Manage server settings. 
 
Enter the following settings: 
 
Single Sign-On Administrator 
Account: Enter the same user 
name that the SSO service is 
running as. 
 
Enterprise Application 
Definition Administrator 
Account: Enter the same user 
name that the SSO service is 
running as. 
 
Leave the other settings as their 
defaults. 
 
Click OK. 

 

6 Navigate back to the Manage 
Settings for Single Sign-On 
page, and click Manage 
settings for enterprise 
application definitions. Then 
click New Item. 
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Enter the following information 
for your SSO application 
definition: 
 
Display name: ñ<sso id>ò 
Application name: ñ<sso id>ò 
Contact e-mail address: ñyour e-

mail addressò 
Account type: Group  
Authentication type: Windows 

authentication 
Field 1: Display Name: ñusernameò 
(Field 1) Mask: No 
Field 2: Display Name: ñpasswordò 
(Field 2) Mask: Yes 

 
Click OK. 
 
Note: 
ñ<sso id>ò can be any unique 
string that will be used to identify 
this SSO mapping. 
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7 Navigate back to the Manage 
Settings for Single Sign-On 
page, and click Manage 
Account Information for an 
Enterprise Application 
Definition. 
 
Make sure the SSO application 
definition is selected in the dropï
down list box, and then enter 
ñ<DOMAIN>\<Group>ò as the 
group account name. 
 
Click SET. 
 
Note: 
<DOMAIN> can be any valid 
domain, such as REDMOND or 
EUROPE. 
 
<Group> can be any valid 
domain group, such as ñDomain 
Usersò. 
 
 

 

8 Enter the user name and 
password of a user on your 
domain that has access to the 
data sources that you will be 
accessing. 
 
Click OK. 
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9 This puts you back on the 
previous Manage Account 
Information for an Enterprise 
Application Definition page. 
 
Click DONE. 
 
You are done. You can now 
configure Office Excel 2007 
workbooks to use SSO when 
running on Excel Services. 
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Creating a Trusted Data Connection Library with Excel Services 

Workbooks loaded on Excel Services might attempt to use connection files from a Data Connection Library to refresh 
external data. Excel Services will only allow these requests to execute if the Data Connection Library is explicitly marked 
as "trusted" by the Excel Services administrator. The following steps detail how to mark a Data Connection Library as 
trusted for Excel Services. 

 

1 Launch the Central 
Administration page. 
 
On the Start menu, under 
Programs, Microsoft 
Office Server, select 
SharePoint 3.0 Central 
Administration. 
 
 

 

2 On the SharePoint Central 
Administration Web site, 
click SharedServices1. 
 
 
 
 

 
 

3 Under Excel Services 
Settings, click Trusted 
data connection libraries. 
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4 Click Add Trusted 
Connection Library. 

 

5 Type the URL of the Data 
Connection Library you 
want to add. Optionally, 
add a description. 
Click OK. 
 
After completing this step, 
Excel Services is able to 
load data connection (.odc) 
files from that Data 
Connection Library. 
 
Note: 
Data connection files must 
be saved in a Data 
Connection Library. You 
cannot save them to other 
locations types and add 
those locations as Trusted 
Data Connection Libraries. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Page 16 of 118 

© 200 7 Microsoft Corpo ration. All rights reserved.    

By using or providing feedback on these materials, you agree to the attached license agreement.  

 

 

 

 
Building a Report Based on Cube Functions for Excel Web Access 
  



Page 17 of 118 

© 200 7 Microsoft Corpo ration. All rights reserved.    

By using or providing feedback on these materials, you agree to the attached license agreement.  

 

Building a Report Based on Cube Functions for Excel Web Access 
 
Description: 
A new feature of Microsoft® Office Excel® 2007 is a set of functions called ñcube functions.ò These functions retrieve data 
from Microsoft SQL ServerÊ 2005 Analysis Services by using Unified Dimensional Models (UDMs) or cubes. In this 
scenario, you build a Top Selling Products report based on data stored in the Adventure Works UDM by using this new 
Office Excel 2007 feature. Once the report is built, you publish the workbook to Excel Services where users will be able to 
interact with it in Microsoft Office Excel Web Access. 
 
Finished Product: 
Once you are done, you will have the following: 

2. A workbook that displays the Top Selling Products based on the country, year, and measure that the user 
specifies. 
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Collateral: 
The following collateral is provided with this tutorial: 
 

1. Sample Workbook.xlsx - The workbook that is used in this tutorial, in case you do not want to create the 
workbook yourself. 

 
Prerequisites: 
This tutorial assumes that you have already completed the following tasks: 
 

2. Installed Microsoft Office SharePoint® Server 2007. 
 

3. Configured Excel Services. 
a. Configured a document library or entire server to be a ñTrusted Locationò for Excel Services.  

Please see: 
Setting up the Server - Step 1 - Creating a Trusted Location with Excel Services.doc 
 

b. Optionally set up Single Sign-On to access the Adventure Works database and cube.  
Please see: 
Setting up the Server - Step 2 - Configuring Single Sign-On for Excel Services.doc 
 

c. Configured a Data Connection Library to be a Trusted Data Connection Library for Excel Services. 
Please see: 
Setting up the Server - Step 3 - Creating a Trusted Data Connection Library with Excel Services.doc 
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Steps: 
 

1 First, we create the data 
connection that we will use 
in the workbook. 
 
Create a new workbook in 
Office Excel 2007 by 
opening Office Excel 2007. 
 
To import external data into 
the workbook, on the Data 
tab, in the Get External 
Data group, click From 
Other Sources, and then 
click From Analysis 
Services. 
 
Note: 
This section assumes that 
you have configured Excel 
Services to have a Trusted 
Data Connection Library. 
 
If you already have a data 
connection available in the 
data connection library for 
AdventureWorks, you can 
skip this section of the 
tutorial and begin on Step 
8. 
 

 

2 The Data Connection 
Wizard dialog box will 
appear. 
 
Enter the name of a 
Microsoft Analysis Services 
server that contains the 
Adventure Works DW and 
the Adventure Works cube, 
and then click Next. 
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Make sure that Adventure 
Works DW is selected in the 
drop-down list and that 
Adventure Works is 
selected as the cube to 
connect to, and then click 
Next. 

 

 

3 Next, enter the name 
"Adventure Works" in the 
Friendly Name box (you 
can add a description or 
search keywords at this 
time), then click Finish to 
save the data connection 
(.odc) file.  When Office 
Excel 2007 displays the 
Import Data dialog box, 
click Only Create 
Connection, and then click 
OK. 
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4 On the Data tab, in the 
Manage Connections 
group, click Connections, 
and then double-click the 
ñAdventure Worksò 
connection.  
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5 If you have set up and 
configured SSO as is discussed 
in the prerequisites section, do 
the following: 
 
 
1. On the Data tab, in the 
Connections group, click 
Connections, select the 
ñAdventure Worksò 
connection, and then click 
Properties. 
 
2. In the Connection 
Properties dialog box, click 
the Definition tab, and then 
click Authentication 
Settings to display the 
Excel Services 
Authentication Settings 
dialog box. 
 
3. In the Excel Services 
Authentication Settings 
dialog box, click SSO and 
then enter the SSO ID in the 
SSO ID field that you 
created when you 
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configured Single Sign-On. 
Make sure that the account 
you configured for SSO has 
appropriate permissions to 
access data stored on the 
server running Analysis 
Services. 
 
4. Click OK. 
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6 In the Connection 
Properties dialog box, click 
the Definition tab, click 
Export Connection File, 
and save the connection file  
to a Data Connection 
Library. 
 

 

7 Navigate by using Internet 
Explorer to the Data 
Connection Library. To 
approve the check-in and to 
make the connection public: 
In the Data Connection 
Library list view, point to 
Adventure Works, click the 
arrow next to it, and then 
click Approve/reject.  
 
In the Approve/reject Web 
page that opens, select 
Approved. This item will 
become visible to all 
users. Then click OK. 
 
 
Close Internet Explorer. 
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8 Next, we will create the 
Office Excel 2007 workbook 
that will use the connection 
that is stored in the Data 
Connection Library. 
 
Start Office Excel 2007. On 
the Data tab, in the Get 
External Data group, click  
Existing Connections. 

 

9 In the Existing 
Connections dialog box, 
double click the ñAdventure 
Worksò connection, which is 
the connection that is in your 
Trusted Data Connection 
Library. 
 
 
 
 
 
 
 
 
In the Import Data dialog 
box, click Only Create 
Connection, and then click 
OK. 
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10 Next, enter the following data/formulas into the workbook: 

Name the sheets 

Sheet1 name Report 
  

Enter the report title 

A1 Top Selling Products 
  

Enter the report slicers 

C2 Country 

C3 Year 

C4 Data 

D2 United States 

D3 2004 

D4 Gross Profit 

E2 =CUBEMEMBER("Adventure Works","[Sales Territory].[Sales Territory Country].[All Sales Territories].[" & 
D2 & "]") 

E3 =CUBEMEMBER("Adventure Works", "[Date].[Fiscal].[All Periods].[FY " & $D$3 & "]") 

E4 =CUBEMEMBER("Adventure Works", "[Measures].[" & $D$4 & "]") 
  

Enter the report column headers 

A6 =CUBESET("Adventure Works", "DESCENDANTS([Product].[Product Categories].[All Products],,LEAVES)", 
"Products",2,D6) 

B6 =CUBEMEMBER("Adventure Works", "[Date].[Fiscal].[All Periods].[FY " & $D$3 & "].[H1 FY " & $D$3 & "]") 

C6 =CUBEMEMBER("Adventure Works", "[Date].[Fiscal].[All Periods].[FY " & $D$3 & "].[H2 FY " & $D$3 & "]") 

D6 =CUBEMEMBER("Adventure Works", (E2:E4), "FY 2004") 
  

Enter the report row headers 

A7 =CUBERANKEDMEMBER("Adventure Works", $A$6, ROW(A1)) 

A8: A27 fill down A7 
  

Enter the report data 

B7 =CUBEVALUE("Adventure Works", $A7,$B$6,$E$2,$E$4) 

C7 =CUBEVALUE("Adventure Works", $A7,$C$6,$E$2,$E$4) 

D7 =CUBEVALUE("Adventure Works", $A7,$D$6) 

B8: D:27 fill down B7:D7 
  

Format the report 

A1:D1 Home | Alignment | Merge and Center; Home | Styles | Cell Styles > Heading 1 

A6:D6 Home | Styles | Cell Styles > Heading 2 

D2:D4 Home | Styles | Cell Styles > Input 

E:F Select the columns | Right Click | Hide 

D7:D27 Styles | Conditional Formatting > Data Bars > Light Blue 
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11 When you are done, you 
will have a report that 
looks similar to this 
screen shot. Make sure to 
save your report. 

 

12 In this next step, we will 
add parameters to this 
report. 
 
Select cell D2 and enter 
ñCountryò in the address 
box as seen in the screen 
shot on the right. This will 
create a named range 
that represents this cell. 
 
In a similar fashion, select 
cell D3 and enter ñYearò 
in the address box. 
 
Lastly, select cell D4 and 
enter ñDataò into the 
address box.  
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13 Publish your report to a 
document library in Office 
SharePoint Server 2007 
that is marked as a 
"Trusted Location" for 
Excel Services. 
 
On the File menu, in the 
Publish menu item, click 
Excel Services. 
 
 

 

14 In the Save As dialog 
box, navigate to the 
location where you want 
to save the file, and make 
sure that the Open in 
Excel Services check 
box is checked.  
 
 

 


